Explore and label community features data for a city visitor's map
There are many types of maps you can use to get information.  Topographic maps, for example, show the elevation of a place, and political maps show boundaries between countries.  When making a map, you need to carefully consider what type of map serves your purposes and which elements should be shown.


To complete this exercise you will use basic GIS skills to create a map, making it most useful to a specific audience.  You will add data to the map, find and identify information on the map, and determine appropriate symbology.  Finally, you will create a presentation layout of the finished map and print it.

The 


 icon indicates questions to be answered.  Write your answers on a separate sheet of paper.
ASK
A group of American history teachers from New England is planning an educational trip to the presidential libraries and memorials in California.  One stop on their trip is the Lincoln Memorial Shrine at the A. K. Smiley Library in Redlands.  It is the only museum, archive, and library dedicated to Abraham Lincoln west of Springfield, Illinois.  You are a member of a Redland's community group that has volunteered to use GIS expertise to prepare informational maps for the teacher's visit to this shrine.

1 Double-click the ArcMap icon on your computer's desktop to start ArcMap.  If you don't have an icon on your desktop, open ArcMap from the Start menu.
2 In the window that appears, select Start using ArcMap with "an existing map" and press OK.  (If no widow appears, click Open from the File menu.)
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3 Navigate to the exercise folder (C:\esri\comgeo\module1) and open map.mxd. 
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A map of streets and landmarks in Redlands, California, displays.  The table of contents for the map symbols and data is presented at the left of the map. The data in the table of contents are called layers and the four layers in this map are landmark, trees, streets, and boundary.

[image: image33.bmp]
3a
What colors are the streets on your map?
[image: image34.bmp]
3b
What business is represented by the eyeglasses symbol?
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3c
What landmark is next to the A.K. Smiley Library?

Now that you have familiarized yourself with the map, you are ready to dig deeper.  One of the powerful features of GIS is the ability to look at the information that is connected to each feature in the map.  Each layer of information in the table of contents has a separate table of data attached to that layer (called an attribute table.)

[image: image36.bmp]
4 From the Tools toolbar, click the Identify tool and position the cursor over the symbol that represents ESRI, Inc., in the map.  Click the symbol. In the Identify Results window, choose the landmark layer.  Click on the ESRI symbol again.
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The Identify Results window displays the name of the feature you clicked in the left column (ESRI, Inc.) Information about that feature is in the right column.
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4a
What type of landmark is ESRI, Inc.?

ESRI is the company that develops and distributes the GIS software that is used in all the ArcGIS projects in this book.

5 Click the symbol for the A.K. Smiley Library on the map.
Information about the A.K. Smiley Library appears highlighted in the Identify Results window.
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5a
What type of landmark is the A.K. Smiley Library?

[image: image40.bmp]
5b
What is the address of the A.K. Smiley Library?

[image: image41.bmp]
5c
Why is this location on the map important to know?

6 Close the Identify Results window.
In addition to historical locations and points of interest, visitors to Redlands will need to find lodging and places to eat.  You will add those additional layers of data to the map you're preparing for them.
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Click the Add Data button.  Navigate to the exercise data folder (C:\esri\comgeo\module1).  Click once on coffee_dessert.shp in the list of files at the left and highlight it.  Hold down the Control (Ctrl) key and click once on RedlandsLodging.shp.  With both files highlighted, click Add.
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EXPLORE
8 Click the small box to the left of RedlandsLodging.  The checkmark in the box disappears, indicating that RedlandsLodging is "turned off" and not displayed in the view.  Turn the layer back on by clicking the box again.
NOTE: The symbol may be a different color on your computer than in the picture below.
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8a
What happened to the map when you turned off RedlandsLodging?
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[image: image45.bmp]
8b
Does the coffee_dessert  layer appear on your map?

8c
Why or why not?
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As the map designer, you have an obligation to make your map as readable and usable as possible for its intended audience.  When RedlandsLodging was added, ArcMap assigned a small, randomly colored dot to represent lodging locations.  You will change that dot to a more appropriate symbol.

9 In the Table of Contents, click the symbol for the RedlandsLodging layer.  The Symbol Selector window will appear.
10 In the Symbol Selector window, scroll down the list of symbols until you find a symbol with a bed.  
[image: image9.png]Symbol Selector

Caegoy: [ A <] Pevew
n 8]
Gas DieselGas  Propane Gas
Options
Colr
m
Sie
Food ToustInfomaion
Ange
2] B
Recresionsl  Lbray Marna
Vekick Sant.
Propetes
] |
MoreSymboks -
Srow/ T sipot
Recreston Save Reset
- - - Carcel





11 If necessary, change the color of the lodging symbol to blue by clicking on the drop down arrow on the box next to the word "Color".  Leave the Size as 18 and Angle as 0.  Click OK at the bottom of the Symbol Selector window.
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11a
What change did you see on the map?
12 Use the procedure from steps 9-11 to change the symbol for coffee_dessert to a food symbol, the color to yellow, and the size to 16. 
Now you will change the name of layers in your legend to make them more readable.

13 Right click on the RedlandsLodging layer.  Click on Properties.  Click the General tab and change the Layer Name to Hotels and Motels.  Click OK.
[image: image47.png]3 Dats Frame
e Toe
A e

@ et

= scale B
Em Seale Text,
[ piture,

bt




[image: image10.png]coffee_dessert

landmark.
M AK. Sy Library

[Jesrume

G Krkorian Thester
Fetorey Hansion
EPast Office

I San Bernadino sz
rees 2





[image: image11.png]Layer, Properties.

Gefyl | Sarce| Slectin| Diely| Symbooy | Fieds | Defriton ey Labeks | Jos & Rt |

LajerNarre:[Hotls nd Hte
v Visible:

Seale Range

Yo can specily the range of scales tis layer wil be showr:

& Show layer at ol scales

Dot show layer when zoomed:

outbeyond 1: [0

(miimum scale]

inbeyond 1: |0 b

(masinum scale)

Cancel Apply





[image: image48.png]



13a
Where does the new title Hotels and Motels appear on your screen?
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13b
Why is it sometimes helpful to change the layer name from the file name to something else?

14 Using the above process, please change the other layer names to match the graphic below.
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The visitors are interested in staying in hotels and motels in Redlands.  Some are interested in staying close to the downtown area of Redlands where the Lincoln Memorial Shrine is located, and others have a preference for a particular hotel chain (Best Western).

You will explore the list of hotels and motels and map them.  First you will look at the attribute table, which contains all the data for each layer.

15 Right click the Hotels and Motels layer.  Click Open Attribute Table.
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16 Look for a Best Western, then click the small box at the left of the record.  Move the attribute table so you can see the entire map.
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16a
What happened to the map?


16b
What Redlands landmark is close to the Best Western?

When you click a record in the attribute table, that record is selected in the table and its corresponding feature is selected in the view.
17 Click the Selection Tab at the bottom on the Table of Contents.  Uncheck all layers except Hotels and Motels.  
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18 Click the Select Feature tool on the Tools toolbar.  Click the symbol for the hotel nearest the A.K. Smiley Library (Lincoln Memorial Shrine).  Look at the attribute table.


18a
What is the name and address of the hotel you selected?
19 Close the Attribute Table.  From the Main menu, choose Selection, Clear Selected Features. Click the Display Tab at the bottom of the Table of Contents.

20 Click the Zoom In tool from the Tools toolbar.  Position your cursor at the top left of the downtown area of Redlands as shown in the picture below.  Click and drag the mouse down and to the right.  When your box is approximately the same size and shape as in the picture, release the mouse button.
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CAUTION: When you zoom, make sure to keep the mouse very still as you click or you may accidentally drag a tiny box and the map will zoom in too much.  If this happens, go to the Tools toolbar and click the Go Back to Previous Extent button once.

To create an informative map for the Redlands visitors, you will label the different features.

21 Right click the Hotels and Motels layer and click Properties.  In the Layer Properties window, click the Labels tab.  Click the Symbol button to open the Symbol Selector window.  Change the size of the font to 9.  Press OK to close the Symbol Selector window.
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The font is now changed for each time you want to label this layer.
22 In the Layer Properties window, click the Label Placement Options button.  At the bottom of the Placement Properties window, put a check next to Place Overlapping Labels.  To save these changes, click OK in the Placement Properties window and click OK to exit the Layer Properties window.
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23 Right click the Hotels and Motels layer and click Label Features.
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The labels appear in the view.  Some overlap.  You will move these labels so you can read them.

24 Right click the Hotels and Motels layer and click Convert Labels to Annotation.  Under Store Annotation, check "In the Map".  Click Convert.  
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25 From the Tools toolbar, click the Select Elements tool and then click Thrift-T-Lodge Motels label.  Blue dashes around the label indicate that the label is selected.  Move the label so that it's to the right of the symbol.  See the picture below.
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26 Click the Pan tool.  Click the map and move it to the left so you can read the entire Thrift-T-Lodge Motels label and still see the symbol for the Krikorian Theater.
27 Click the Select Elements tool and move the labels for the Budget Inn and the Stardust Motel in line with their symbols.
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28 Use the same labeling process you learned in steps 21-24 to label Coffee and Dessert Shops.  For a challenge, try to make the labels red.
NOTE: If you do not check the Place Overlapping Labels, it's possible that some features may not be labeled.

29 Move labels so they can be clearly read and are not overlapping.  
In addition to labeling hotels and motels and coffee and dessert shops, you will need to label major streets in downtown Redlands.  To label some of the city streets individually, you will use the Label tool on the Draw toolbar.

30 Right click on the streets layer and click on Properties.  In the Layer Properties window, click on the Labels tab.  Change the Label Field to STREET_NAM.  Click OK.
31 On the Draw toolbar, click on dropdown arrow next to the New Text button. Click on the Label tool. Make sure that the options "Place label at position clicked" and "Use properties set for the feature layer" are selected in the Labeling Options window. Then close the window by clicking the X at the top right.  
[image: image23.png]pawngw R O~ A~ fawa St s B U Av Ay Sy o~




[image: image24.png]ppeting Options

Placement
€ Automatcaly find best placement
& Place label at posiion cicked.

Label Style-
& Use propeties set for the feature laper.
" Choose astyle




32 Move your mouse on to the map and click the freeway southeast of the Stardust Motel.
The label I10 appears in the same spot as where you clicked the freeway.  Click back on the label to move the label into a position where it can be read easily.
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33 Use the labeling procedure you learned in step 31 to label the following streets:

Colton
Redlands
Orange
State
Eureka
Citrus
Vine
When you're finished with the labeling, your map should look similar to the one below:
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As an added tool for the Redlands visitors, you will create a 0.5-mile circle around the Lincoln Memorial Shrine at the A.K. Smiley Library.  This will show which locations are within walking distance of the Lincoln Memorial Shrine.

ANALYZE

34 On the Draw toolbar, click on the drop down arrow next to the New Rectangle tool.  Choose the New Circle tool as in the picture below.  Click the symbol for the A.K. Smiley Library.  Drag your cursor out from the symbol until you've created a circle with a 0.5-mile radius.
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NOTE: The radius measurement is located at the bottom left of your program window.  If necessary, zoom out and reposition your map so the entire circle is visible and centered in the view.

35 Double click the circle and change the Fill Color to "No Color" in the Properties window and click OK.
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36 From the File Menu, click Save As.  If you are in a classroom environment, ask your instructor for directions on how to rename your map document and where to save it (e.g., map_abc.mxd where "abc" represents your initials).  Save your project.
Now that your map is clearly symbolized and labeled, you are ready to prepare it for printing.  In the next steps, you will create a layout to display your completed map.  Your layout will include the map, a title, a north arrow, a scale bar, your name, and the date the map was created.

37 First, make any adjustments to your map.  When you're satisfied with the way it looks, click Layout View button at the bottom left of the map.
When you change to Layout View, ArcMap automatically transfers your open files in the Data View to a layout.
38 From the File Menu, click Page Setup.  Under Page Orientation choose Landscape and click OK.
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Now you will add elements such as a scale, north arrow, legend, and title.

39 From the Insert Menu, click Legend.  A Legend Wizard window will appear.  Please take all of the defaults by clicking Next at the bottom of all the screens.  Once you have clicked Finished on the last screen, a legend will be placed on your map.  Click and drag the legend and move it to the side of the map as in the picture below.

40 Return to the Insert Menu and click North Arrow.  Choose a north arrow from the left side of the North Arrow Selector window and click OK.  Click and drag the arrow to the location shown in the picture below.
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41 Using the same process described in steps 39 and 40, return to the Insert Menu and click on Scale Bar.  You can make any of these items bigger by clicking and dragging one of its handles.  
42 Click on the New Text tool on the Draw toolbar.  Then, change the size of the text to 36.  Drag the mouse to the top of the map and click.  Change Text to Downtown Redlands and press Enter.  
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43 Click and drag Downtown Redlands so it's centered.  Click on the map outside of the label to unselect the text box.   
44 Click the New Text tool again, change the text size to 14.  Return to the map and click a new text box.  Type your name and date.  

45 Click and drag the name and date so they're centered between the map legend and the north arrow.  Resize and move other graphics until you are happy with the way the layout looks.

NOTE:  The layout often appears illegible and small on the computer screen.  To check your work, you can zoom in on the layout using the Layout toolbar.  When you print the map, you will be able to read all of the labels and symbols you worked so hard to create.
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ACT
46 From the file menu, click Print.  Click Setup to choose your printer settings (check Landscape and send to a color printer if one is available).  Click OK to send the layout to the printer.
If you didn't like the way your map printed out, make adjustments to your layout and reprint.

47 From the file menu, click Save.  If you are in a classroom environment, ask your instructor for directions on how to rename the map document and where to save it.  For example, name your map document map_abc.mxd where "abc" represents your initials.  Write down the new document name and location on a separate sheet of paper.  Exit ArcMap.
SUMMARY

In this exercise, you:

· Opened an ArcGIS document and added data to it

· Observed spatial relationships between layers and explored the attribute table

· Labeled features

· Created and printed a layout of Redlands, California, for visitors
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